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Level: Grade 4-6 • Topic: Art Design • Subjects: Arts, History, Heritage & Culture 

 

ᑎᑎᕋᖅᑎ 

ᐄᐊᓐ ᒪᑭᓖᓐ (Ian MacLean) 
ᐄᐊᓐ ᒪᑭᓖᓐ ᐱᓕᕆᔨᒻᒪᕆᐅᕗᖅ ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᖅ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ ᑕᒪᒃᑯᓂᖓ 
ᐋᖅᑭᒃᓱᐃᔨᒻᒪᕆᐅᕗᖅ/ᖃᕋᓴᐅᔭᒃᑯᑦ ᐊᔾᔨᙳᐊᑦ ᓅᑎᑕᐅᓲᖑᓂᖏᖕᓂᒃ ᑎᑎᖅᑐᒐᖅᑎᓗ 
ᐃᖅᑲᓇᐃᔮᖃᖅᓯᒪᔪᑐᖃᖅ ᐱᙳᐊᖅᑐᓕᕆᕙᓐᓂᖏᑦ ᖃᕋᓴᐅᔭᒃᑯᑦ 16 ᐊᕐᕌᒎᓕᖅᑐᓂᑦ. 
ᐊᓂᖅᓵᙱᑯᑖᑲᐃᓐᓇᕈᓐᓇᖅᑐᖅ 10 ᒥᓂᔅᓯᓂᒃ ᐊᑯᓂᐅᑎᒋᔪᖅ (ᓈᓴᐅᑎᓂᒃ ᓵᓚᒃᓴᒃᑲᓐᓂᕈᓐᓇᖅᑐᑎᑦ 
ᖃᐅᔨᒍᓐᓇᕈᕕᐅᒃ ᓱᑯᑦᑎᐊᓂ ᑕᒪᓐᓇ ᑐᑭᓯᒋᐊᕈᑎ ᐊᑐᕐᓂᕐᒪᖔᕐᒥᐅᒃ)!  

 

ᑐᑭᓯᒋᐊᙵᕈᑎᖏᑦ 
ᖃᕋᓴᐅᔭᒃᑯᑦ ᑎᑎᖅᑐᒐᐅᔭᕈᑎ ᕿᒥᕐᕈᔭᐅᓂᖅᓴᐅᓲᖑᓪᓗᑎᑦ, ᐋᖅᑮᓗᓂ ᑐᑦᑕᕐᕕᐅᓪᓗᐊᕋᔭᖅᑐᒥᒃ 
ᐱᙳᐊᕐᕕᐅᒐᔭᖅᑐᑦ ᐃᓂᖏᑦ ᒪᕐᕈᐃᓕᖅᑲᖓᔪᕐᔫᔮᖅᑐᑦ ᐱᙳᐊᕈᑏᑦ ᐊᒻᒪᓗ ᖃᕋᓴᐅᔭᓕᕆᔾᔪᑎᓂᒃ, ᑖᒃᑯᐊ 
ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᑐᙵᕕᖃᖅᑎᑎᓪᓚᑦᑖᖅᐳᑦ ᑖᒃᑯᐊ ᖃᕋᓴᐅᔭᒃᑯᑦ 
ᑎᑎᖅᑐᒐᐅᔭᕈᑎ ᐃᓂᒃᓴᖃᖁᓪᓗᒋᑦ. ᐃᓗᓕᖃᓗᐊᖅᑐᑦ ᐊᒥᓲᓛᖑᓂᖏᖕᓂᒃ ᐱᙳᐊᕈᑎᑉ 
ᑎᑎᖅᑐᒐᐅᔭᖅᓯᒪᓂᖏᖕᓂᒃ. ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᕆᒐᔭᖅᑕᖏᑦ ᐱᙳᐊᕈᑎᒥ Tilesets, 
ᓄᐊᑕᐅᓯᒪᔪᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᐱᙳᐊᕈᑎᓕᕆᓂᕐᒥ, ᐋᖅᑭᒃᓱᐃᔨᓂᒃ 
ᓴᓇᑎᑦᑎᒍᓐᓇᕐᒪᑕ ᐊᖏᔪᒥᒃ ᐱᙳᐊᕐᕕᐅᖃᑦᑕᕋᔭᖅᑐᓂᒃ ᐃᓂᖏᖕᓂᒃ ᑕᐅᑐᒐᒃᓴᑦᑎᐊᕙᒡᒍᑕᐅᓪᓗᑎᑦ 
ᐊᒥᓱᓕᐅᕐᓗᓂ ᐊᒻᒪᓗ ᐃᓕᓯᓗᓂ ᐊᑐᐃᓐᓇᐅᒪᔪᓂᒃ ᓴᓇᔭᐅᓯᒪᔪᑦ ᐱᙳᐊᖅᑐᑦ ᐃᓂᒃᓴᕆᒐᔭᖅᑕᖏᑦ ᐱᙳᐊᕐᓗᓂ 
ᐱᙳᐊᕈᑎᒥ. ᐱᒋᐊᕐᓂᖏᑦ ᐊᒻᒪᓗ ᐃᓱᓕᓐᓂᖏᑦ ᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᔪᑉ ᐃᓂᒃᓴᖏᑕ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ 
ᐱᙳᐊᕈᑎᒥ ᐊᖅᑭᓱᖅᑕᐅᓯᒪᓂᖏᑦ, ᓴᓇᔭᐅᓲᑦ ᓇᓕᒧᒌᓕᖅᑎᑕᐅᓪᓗᑎᑦ ᐃᓱᖏᑦ ᑖᒃᑯᐊ ᐃᓂᒃᓴᖏᑕ 
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Lesson Plan 

ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᖅ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ 3A: 
ᐊᑐᖅᑕᐅᓪᓗᐊᓲᑦ ᖃᕋᓴᐅᔭᒃᑯᑦ ᐊᒥᐊᕆᓗᓂ ᒍᕌᐱᒃᔅᒐᐃᔪᓪ 
GraphicsGale 
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ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ, ᐋᖅᑭᒃᓱᐃᔨᒥᒃ ᐊᒥᐊᕆᑎᑦᑎᒍᓐᓇᖅᑐᑦ ᐊᖏᔫᑎᓪᓗᒋᑦ ᐊᔾᔨᐸᓗᖏᑦ 
ᐃᓂᒃᓴᖏᑕ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᐊᒻᒪᓗ ᐃᔨᖅᑕᐅᓗᑎᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ 
ᐱᙳᐊᕈᑎᒥ ᐃᓕᔭᐅᔪᑦ ᐊᒻᓗ ᐊᑐᓕᖅᑭᑦᑕᐅᓪᓗᑎᑦ ᓴᖅᑭᑲᓐᓂᕋᔭᙳᐊᕐᓂᖃᕋᓱᒋᔭᑦ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᓂᒃ 
ᐊᒥᐊᕆᓗᑎᑦ. ᐱᓪᓚᑦᑖᙳᐊᖑᔮᖅᑐᑦ 3D ᐱᙳᐊᕈᑏᑦ ᐊᑐᕋᔭᕐᒥᔪᑦ ᑕᐃᒪᓐᓇᐃᓕᐅᕐᓗᑎᑦ ᐊᒥᐊᕆᑦᑎᐊᕐᓗᑎᑦ 
ᑲᑎᙵᑎᐊᕐᓂᖅᓴᐅᔫᔮᕐᓂᐊᕐᒪᑕ ᑎᑎᖅᑐᒐᐅᔭᖅᓯᒪᔪᑦ, ᐋᖅᑭᒃᓱᐃᓕᕐᓗᑎᑦ ᐃᓱᓕᑦᑕᕐᕕᖃᙱᑦᑐᓂᒃ, ᐃᓂᒃᓴᖏᑦ 
ᐃᓕᔭᐅᔪᓐᓇᕐᓗᑎᑦ ᐊᔾᔨᙳᐊᑦ ᑕᐃᒪᓐᓇᐃᓕᐅᖅᑎᓪᓗᑎᑦ ᐸᒻᒪᕆᐅᕗᖅ ᐊᑑᑎᖃᑦᑎᐊᖅᑐᓂ. ᑕᕝᕙᓂ 
ᐃᓕᓐᓂᐊᒐᒃᓴᒥ ᐃᓕᓐᓂᐊᖅᑏᑦ ᐃᓕᓐᓂᐊᕋᔭᖅᑐᑦ ᐋᖅᑭᒃᓱᐃᓗᑎᑦ ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᑦ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᔪᓂᒃ 
ᐊᒥᐊᕆᓗᑎᑦ ᐃᓕᓐᓂᐊᓚᐅᖅᑕᖏᑦ ᐃᓕᓐᓂᐊᒐᒃᓴᖅ 1 ᐊᒻᒪᓗ 2-ᒥ. 

ᖃᓄᐃᑦᑑᓂᖏᑦ 

ᐅᕝᕙ ᐅᑯᐊ ᖃᑦᑏᓐᓇᐅᒐᓗᐊᑦ ᐆᑦᑑᑏᑦ ᐱᙳᐊᕐᑐᖃᖅᑎᓪᓗᒍ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐃᓂᒃᓴᓕᐊᕆᔭᐅᓯᒪᔪᑦ 
ᐊᔾᔨᒌᙱᑦᑐᑎᒍᑦ ᑕᐅᑐᒐᒃᓴᐅᓪᓗᑎᑦ: 

ᓴᓂᒧᑦ ᓴᖅᑭᖅᑎᑕᐅᕙᓪᓕᐊᓂᖏᑦ: 

  

ᖁᓛᓂ−ᐊᒻᒧᑦ ᑕᑯᒃᓴᐅᓂᖏᑦ: 

   

ᐱᖓᓱᐃᓕᖅᑲᖓᔫᔮᖅᑐᓂᒃ ᑕᑯᒃᓴᐅᑎᑦᑎᓗᓂ ᒪᕐᕈᐃᓕᖅᑲᖓᔫᔮᖅᑐᒃᑯᑦ ᑕᑯᒃᓴᐅᓂᐊᕐᒪᑕ: 

2 



Pinnguaq • ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᖅ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ 3A 

 

 

ᐊᑐᓂ ᖁᓛᓃᑦᑐᑦ ᐆᑦᑑᑏᑦ ᑕᐃᑲᙶᖅᓯᒪᕗᑦ ᐱᓕᖅᑭᑦᑖᖅᑎᑕᐅᓪᓗᑎᑦ ᑕᐃᑲᓂᒃᓴᐃᓐᓇᖅ ᐱᙳᐊᖅᑕᐅᔪᑦ 
ᑭᖑᓕᕇᑦᑐᓂᒃ. ᓴᓂᒧᑦ ᓅᑕᐅᓗᑎᑦ ᐊᔾᔨᙳᐊᑦ ᑕᑯᓂᐊᖅᑕᐅᒍᓐᓇᕐᓂᖏᑦ ᐊᔾᔨᙳᐊᖏᑦ ᑕᑯᒃᓴᐅᑎᑦᑎᕗᑦ 
ᐊᔾᔨᓕᐅᖅᑕᐅᓯᒪᔪᓂᒃ ᑕᐃᑲᙵᑦ ᑯᓇᒥ ᑲᔅᓕᕙᓂᐊ Castlevania ᐱᙳᐊᒐᐃᑦ ᐊᔾᔨᒌᙱᑦᑐᑦ ᑭᖑᓕᕇᓂᒃ, 
ᓯᕗᓪᓕᖅᐹᖅ 1986−ᖑᑎᓪᓗᒍ ᐱᙳᐊᒐᑦ ᓴᓇᔭᐅᓯᒪᔪᑦ, ᐊᒻᒪᓗ 2005-ᒥ ᓂᓐᑎᐊᓐᑐ DS ᓴᓇᔭᐅᓯᒪᓂᖏᑦ. 
ᖁᓈᓂ ᐊᒻᒧᑦ ᐊᔾᔨᙳᐊᖏᑦ ᑕᑯᒃᓴᐅᑎᑦᑎᕗᑦ ᔅᑯᐃᐅᕐᓵᑉᔅᑦ ᑭᖑᓪᓕᖅᐹᒥ ᐊᑐᖅᑕᐅᔪᒪᔪᑦ ᐱᙳᐊᒐᖅ Final Fantasy 
ᐊᑐᕋᒃᓴᐅᔪᑦ NES (1987) ᐊᒻᒪᓗ ᑭᖑᓪᓕᖅᐹᒥ ᐊᑐᖅᑕᐅᔪᒪᔪᑦ III ᐱᙳᐊᒐᖅ Final Fantasy III SNES 
(1984-ᒥ). ᑭᖑᓪᓕᖅᐹᒥᓗ, ᐱᖓᓱᐃᓕᖅᑲᖓᔫᔮᖅᑐᓂᒃ ᑕᑯᒃᓴᐅᑎᑦᑎᓗᓂ ᒪᕐᕈᐃᓕᖅᑲᖓᔫᔮᖅᑐᒃᑯᑦ 
ᑕᑯᒃᓴᐅᓂᐊᕐᒪᑕ ᐊᔾᔨᙳᐊᖏᑦ ᑕᐃᑲᙶᖓᔪᑦ ᑐᑭᓯᒋᐊᕈᑏᑦ ᑲᓇᓐᓇᕐᒥ ᓴᑐᕋᓐ SNES (1993)−ᒧᑦ ᐱᙳᐊᒐᕐᓄᑦ 
ᐊᒻᒪᓗ ᐊᔾᔨᙳᐊᖏᑦ ᕼᐃᐅᕐᕗᕋᐃᓐᑦ ᐊᔾᔨᙳᐊᖏᑦ ᐱᙳᐊᒐᒃᓴᒥ ᐅᑉᐱᕐᓂᓕᕆᓂᕐᒨᖓᙳᐊᖅᑐᑦ ᑭᖑᕚᖏᑦ 
ᓴᑐᕋᓐ ᐅᑎᖅᐳᖅ ᐊᑐᕋᒃᓴᐅᓪᓗᑎᑦ PC−ᒧᑦ (2013). ᐊᑐᓂ ᐊᔾᔨᙳᐊᖏᑦ ᑕᑯᒃᓴᐅᑎᑦᑎᕗᑦ ᑎᑎᖅᑐᒐᐅᔭᖅᓯᒪᔪᑦ 
ᓴᙱᓕᖅᐸᓪᓕᐊᓂᖏᑦ ᓇᓗᓇᐃᔭᖅᓯᒪᔪᓂᒃ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᖃᕈᓐᓇᕐᓗᑎᑦ, ᑕᑯᒥᓇᖅᑐᑯᓘᓪᓗᑎᑦ, ᑐᓄᐊ 
ᐊᔾᔨᙳᐊᖓ ᐊᑐᕐᕕᐅᔪᖅ ᐊᑐᓕᖅᑭᑦᑕᐅᓪᓗᑎᑦ ᐃᓗᓕᒃᓴᖏᖕᓂᒃ. ᐅᓪᓗᒥᐅᓂᖅᓴᑦ ᐱᙳᐊᕈᑏᑦ ᐊᑐᓲᑦ 
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ᐊᔾᔨᒌᙱᑦᑐᓂᒃ ᓴᓇᔭᐅᓯᒪᔪᓂᒃ, ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᐊᒥᓱᓕᐊᕆᔭᐅᓯᒪᔪᑦ 
ᐊᔾᔨᒌᙱᓐᓂᖃᒐᓚᒃᑎᑕᐅᓪᓗᑎᑦ, ᑕᑯᒃᓴᐅᓗᐊᕐᓂᖓᙱᒻᒪᑕ ᐊᑐᓕᖅᑭᑦᑕᐅᓯᒪᓂᖏᑦ. 

ᐃᓕᓐᓂᐊᖅᑕᐅᓇᓱᐊᕐᓂᖏᑦ 
ᐃᓕᓐᓂᐊᖅᑏᑦ ᐃᓕᓐᓂᐊᕋᔭᖅᑐᑦ ᐊᐅᓚᓂᖏᖕᓂᒃ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᐊᒻᒪᓗ ᖃᓄᖅ 
ᓇᒻᒥᓂᖅ ᐋᖅᑭᒃᓱᐃᒍᓐᓇᕐᒪᖔᕐᒥᒃ. ᐱᕙᓪᓕᐊᒍᑎᖃᕐᓗᑎᑦ ᐅᐊᑦᑎᐊᕈ ᐃᓕᓐᓂᐊᒐᒃᓴᐅᖅᑲᐅᔪᓂᒃ 
ᓴᓇᒋᐊᓯᓂᐊᖅᑐᑦ ᐱᒻᒪᕆᐅᔪᓂᒃ ᐱᙳᐊᕈᑎᑉ ᑐᙵᕕᖏᑕ ᐃᓂᒃᓴᖏᖕᓂᒃ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ. 
ᐃᓕᓐᓂᐊᖅᑏᑦ ᐃᓕᓐᓂᐊᕋᔭᕐᒥᔪᑦ ᖃᓄᖅ ᑲᒪᔪᓐᓇᕐᒪᖔᕐᒥᒃ ᖁᓕᕇᑦᑐᓂᒃ ᐊᒻᒪᓗ ᓴᖅᑭᔮᖅᑎᑕᐅᓂᖏᖕᓂᒃ 
ᑕᐃᑲᓂᒃᓴᐃᓐᓇᖅ ᐊᔾᔨᙳᐊᕐᒥ ᓴᓇᔭᐅᓯᒪᔪᓂᒃ ᐊᑐᖅᑕᐅᓪᓗᓂ ᖃᕋᓴᐅᔭᓕᕆᔾᔪᑎ ᒍᕌᐱᒃᔅᒐᐃᔪᓪ 
GraphicsGale. 

ᑕᐃᒎᓯᖏᑦ 
● ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ − ᐊᔾᔨᙳᐊᖅ ᑎᑎᖅᑐᒐᐅᔭᖅᓯᒪᔪᑦ ᐃᓗᓕᒃᓴᖏᑦ 

ᖃᓄᐃᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ ᐊᑐᖅᑕᐅᓲᑦ ᓴᓇᔪᖃᖅᑎᓪᓗᒍ ᖃᓄᐃᑦᑐᙳᐊᖑᒐᔭᕐᒪᖔᕐᒥᒃ ᐃᓂᒃᓴᖏᑦ 
ᖃᕋᓴᐅᔭᒃᑯᑦ ᐱᙳᐊᕈᑎᓕᐅᕐᓗᓂ. 

● ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᑦ − ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ 
ᐃᓗᓕᓖᑦ ᑕᒪᐃᓐᓂ ᖃᓄᐃᑦᑐᙳᐊᖑᓂᖏᖕᓂᒃ ᐃᓗᐊᓂ ᐱᙳᐊᕈᑎᒧᑦ ᐅᕝᕙᓘᓐᓂᑦ ᐱᙳᐊᒐᒃᓴᑉ 
ᐃᓚᖓᓂᒃ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᑦ. 

● ᐱᒋᐊᕐᓂᖏᑦ ᐊᒻᒪᓗ ᐃᓱᓕᓐᓂᖏᑦ ᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᔪᑉ ᐃᓂᒃᓴᖏᑕ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ 
ᐋᖅᑭᓱᖅᑕᐅᓂᖏᑦ −  ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ, ᐅᕝᕙᓘᓐᓃᑦ ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ 
ᖃᓄᐃᑦᑑᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ, ᐃᓕᔭᐅᓲᑦ ᐊᑭᐊᓄᑦ ᑕᑯᒐᒃᓴᐅᓂᖃᙱᓪᓗᑎᑦ ᓱᑯᑦᑎᐊᓄᑦ ᐃᓱᓕᓐᓂᖓᓂᒃ 
ᐊᒻᒪᓗ ᐱᒋᐊᕐᓂᖓᓂᒃ ᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᔫᑉ.  

● ᖃᓕᕇᓐᓂᖏᑦ − ᑕᑯᒃᓴᐅᔪᖅ “ᖁᑦᑎᓐᓂᖓ” ᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᓯᒪᔪᑦ ᓇᑲᑎᕆᓂᕐᒧᑦ ᐸᐃᑉᐹᒃᑯᕕᖓ 
ᐃᓛᒃᑰᖓᔪᓂᒃ ᐊᔾᔨᙳᐊᕐᓂᒃ ᐅᕝᕙᓘᓐᓃᑦ ᐃᓗᓕᖏᖕᓂᒃ ᓴᓇᔭᐅᔪᓐᓇᕐᓂᐊᕐᒪᑕ ᐊᒻᒪᓗ 
ᐊᑐᖅᑕᐅᒍᓐᓇᕐᓗᑎᑦ ᐊᓯᔾᔨᖅᑕᐅᓗᑎᑦ ᑕᐃᑲᓂᒃᓴᐃᓐᓇᖅ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒻᒥ, ᐊᑦᑐᐃᓂᖃᙱᓪᓗᓂ 
ᐊᓯᖏᖕᓂᒃ ᐃᓗᓕᖏᖕᓂᒃ. 

● ᐱᙳᐊᕈᑎᒥ ᐃᓕᔭᐅᓯᒪᓂᖏᑦ ᐊᔾᔨᒌᙱᑦᑐᒡᒍᑏᑦ ᐃᓂᖏᑦ ᐊᒥᓱᓂᑦ ᐋᖅᑭᒃᓱᐃᑎᑦᑎᒍᓐᓇᐅᑎᖓ − 
ᐊᔾᔨᒌᙱᑐᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᑕᐃᑲᓂ ᐊᒥᓱᒡᒍᑕᐅᔪᓂᒃ 
ᐃᓂᒃᓴᖏᖕᓂᒃ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᖕᓂᒃ ᐱᙳᐊᕈᑎᒥ ᐊᒥᓱᑎᒍᑦ ᐋᖅᑭᓱᖅᑕᐅᓯᒪᓂᖃᕈᓐᓇᖅᑐᑦ. 

ᑐᑭᒧᐊᕈᑏᑦ ᐊᐱᖅᑯᑕᐅᔪᑦ 
1. ᑭᓲᒻᒪᑦ “ᐋᖅᑭᓱᖅᑕᐅᕐᓂᖏᑕ ᐃᓗᓕᖏᑦ”? 
2. ᑭᓲᒻᒪᑕ ᐊᑐᖅᑕᐅᓪᓚᕆᓲᑦ ᐊᑐᖅᑕᐅᓕᖅᑐᑎᑦ ᐋᖅᑭᓱᖅᓯᒪᐅᕐᓂᖏᑕ ᐃᓗᓕᒃᓴᖏᖕᓄᑦ ᐊᑐᖅᑕᐅᒐᔭᖅᑐᑦ 

ᐱᙳᐊᕈᑎᓕᐅᕐᓗᓂ? (ᐆᑦᑑᑎᒋᓗᒋᑦ, ᐋᖅᑭᔅᓱᒐᑦ ᓚᐃᒍ, ᐋᖅᑭᒃᓱᒐᑦ ᐃᒡᓗᙳᐊᓕᐊᕆᔭᒃᓴᑦ, 
ᐋᖅᑭᓱᖅᑕᐅᓯᒪᒍᓐᓇᖅᑐᑦ, ᐊᖅᑯᑎᑯᑖᑦ/ᐊᖅᑯᑏᑦ ᓴᓇᒐᒃᓴᑦ, ᐊᓯᖏᓪᓗ) 

3. ᐃᓚᖏᑦ ᑭᓲᕙᑦ ᐃᑲᔫᑕᐅᔪᓐᓇᖅᑐᑦ ᐋᖅᑭᓱᖅᑕᐅᓂᖏᑕ ᐃᓗᓕᒃᓴᖏᖕᓄᑦ 
ᐱᙳᐊᕈᑎᓕᐊᕆᔭᒃᓴᐅᒐᔭᖅᑐᑎᑦ?  
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ᐃᓕᓐᓂᐊᕈᑎᒃᓴᓄᑦ ᑲᓱᖅᓯᒪᓂᖏᑦ 
ᑖᓐᓇ ᐃᓕᓐᓂᐊᒐᒃᓴᖅ ᓇᓕᒧᓐᓂᖃᑦᑎᐊᕕᐅᑎᑉᐳᖅ ᓴᓇᙳᐊᕐᓂᕐᒧᑦ, ᖃᕋᓴᐅᔭᓕᕆᓂᕐᒧᑦ ᐊᒻᒪᓗ 
ᓱᓇᒃᑯᑖᓕᕆᓂᕐᒧᑦ ᐃᓕᓐᓂᐊᕈᑎᒃᓴᓂᒃ ᐃᓕᓐᓂᐊᖅᑕᐅᓗᑎᑦ ᓄᑖᕐᓂᒃ ᖃᕋᓴᐅᔭᓕᕆᔾᔪᑎᓄᑦ ᐊᒻᒪᓗ 
ᐋᖅᑭᒃᓱᐃᓗᓂ ᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᒍᓐᓇᖅᑐᑦ ᐱᙳᐊᕈᑎᒃᓴᑦ ᐃᓗᓕᖏᑦ. 

 

ᓱᓇᒃᑯᑖᑦ 
● ᒍᕌᐱᒃᔅᒐᐃᔪᓪ GraphicsGale − ᖃᕋᓴᐅᔭᒃᑯᑦ ᐱᓗᒍ ᒍᕌᐱᒃᔅᒐᐃᔪᓪ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 

https://graphicsgale.com/us/download.html) 
● ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᑎᑎᕋᕋᒃᓴᑦ − ᖃᕋᓴᐅᔭᒃᑯᑦ ᐱᓗᒋᑦ ᐱᖁᑎᖃᕐᕕᒻᒥ 

ᐸᐃᑉᐹᒃᑯᕕᒻᒥ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 
https://drive.google.com/file/d/1o_9PHhBmPtT-Xd41Jneky5Kt8siqsMlk/view) 

● ᐊᓪᓕᕉᔮᒃ 
● ᓂᐱᑎᒐᖅ ᐊᒻᒪᓗ ᑎᑎᕋᕐᕕᐅᓯᒪᙱᑦᑐᖅ ᐸᐃᑉᐹᖅ ᐊᓕᓚᔪᖅ (ᐊᑐᖅᑕᐅᔪᒪᓐᓂᕈᑎᒃ) 

 

ᖃᕋᓴᐅᔭᒃᑰᙱᑦᑐᖅ ᖃᓄᐃᓕᐅᕈᑎᒃᓴᑦ 

ᐊᓪᓕᕉᔭᕐᓗᒋᑦ ᐃᓕᓗᒋᓪᓗ ᐆᒪᔪᙳᐊᖃᕐᕕᒃ 
2D ᒪᕐᕈᐃᓕᖅᑲᖓᙳᐊᖅᑐᑦ ᑕᑯᓗᒋᑦ ᐊᑐᓲᑦ ᐋᖅᑭᓱᖅᓯᒪᐅᕐᓂᖏᑦ ᐃᓂᒃᓴᕆᒐᔭᖅᑕᖏᑦ ᐱᙳᐊᕈᑎᒥ 
ᐊᔾᔨᒌᙱᑦᑐᑎᒍᑦ ᐊᒥᓱᒡᒍᑏᑦ ᐋᖅᑭᓱᖅᑕᐅᓗᑎᑦ ᑭᖑᓕᕇᓐᓂᖏᑎᒍᑦ ᓴᓇᓂᐊᕐᒪᑕ ᐊᒥᓱᒻᒪᕆᖕᓂᒃ ᐊᔾᔨᒌᙱᑦᑐᓂᒃ 
ᐊᕙᑎᕆᔭᐅᒐᔭᖅᑐᓂᒃ ᐱᙳᐊᕕᒃᓴᐅᓗᑎᑦ ᐱᙳᐊᕈᑎᒃᑯᑦ ᐊᑐᖅᓯᓐᓈᕐᓗᑎᓪᓗ ᑐᖔᓂᐅᙱᑦᑐᖅ 
ᐱᖁᑎᓪᓚᑦᑖᓂᒃ. ᐱᖃᓯᐅᑎᓯᒪᔪᑦ ᐃᑲᔫᑎᒃᓴᓂᒃ ᑕᕝᕙᓂ ᐃᓕᓐᓂᐊᕈᑎᒃᓴᒧᑦ ᑎᑎᕋᕋᒃᓴᐅᕗᑦ ᐸᐃᑉᐹᖅᑎᒍᑦ 
ᐱᔭᕆᐊᑭᑦᑐᑯᓗᐃᑦ ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᐃᓕᔭᐅᓯᒪᓂᒪᐊᖅᑐᑦ 
ᐆᒪᔪᖃᕐᕕᙳᐊᖅᓴᑉ ᓇᑎᒃᓴᖓᓂᒃ. ᑕᑯᒃᓴᐅᖁᓪᓗᒋᑦ ᓱᖏᐅᑎᒐᒃᓴᑦ ᐊᒥᓱᓄᑦ ᖃᓄᐃᓕᐅᕈᑎᖏᔭᐅᓕᕐᓗᑎᑦ 
ᑕᐃᑲᓂ ᐊᒥᓱᒡᒍᑎᓂᒃ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᕆᒐᔭᖅᑕᖏᑦ ᐱᙳᐊᕈᑕᐅᓂᐊᖅᑐᒥᒃ, ᐊᓪᓕᕉᔭᕐᓗᒋᑦ 
ᐃᓂᒃᓴᕆᒐᔭᖅᑕᖏᑦ ᐃᓗᐊᓃᒃᑲᔭᖅᑐᑦ ᐱᙳᐊᕐᕕᒋᔭᐅᓂᐊᖅᑑᑉ ᐊᒻᒪᓗ ᐊᑐᕐᓗᒋᑦ ᐋᖅᑭᒃᓱᐃᓗᑎᑦ ᐱᔭᕆᐊᑭᑦᑐᒥᒃ 
ᐆᒪᔪᙳᐊᑦ ᓇᔪᒐᕆᒐᔭᖅᑕᖏᖕᓂᒃ ᐱᙳᐊᕈᑎᑎᒍᑦ. ᓂᐱᑎᕐᓗᒋᑦ ᐸᐃᑉᐹᑦ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᑦ ᐸᐃᑉᐹᕐᒧᑦ 
ᐅᕝᕙᓘᓐᓃᑦ ᐋᖅᑭᒋᐊᑐᐃᓐᓇᕐᓗᒋᑦ ᓱᑯᑦᑎᐊᓃᒃᓴᕆᒐᔭᖅᑕᖏᑦ ᐃᓕᓗᒋᑦ ᑎᓯᔪᒧᑦ. ᑕᒪᐃᓐᓂᓕᒫᑦ ᐃᓂᒃᓴᖏᑦ 
ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᖏᑦ ᐊᑐᖅᑕᐃᓐᓇᐅᔭᕆᐊᖃᙱᑦᑐᑦ. ᐃᓕᓐᓂᐊᖅᑏᑦ ᓴᓇᖃᑎᒌᑦᑐᑦ, 
ᑖᒃᑯᐊ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᑦ ᑲᑎᑕᐅᔪᓐᓇᖅᑐᑦ ᐅᕝᕙᓘᓐᓃᑦ 
ᑕᐅᖅᓯᖅᑕᐅᓗᑎᑦ ᐋᖅᑭᒃᓱᐃᓂᐊᕐᒪᑕ ᐊᒥᓲᓂᖅᓴᓂᒃ ᐅᕝᕙᓘᓐᓃ ᐱᐅᓂᖅᓴᓂᒃ ᐃᓂᒃᓴᕆᒐᔭᖅᑕᖓᓂᒃ 
ᐊᕙᑎᖓᓂᒃ ᐱᙳᐊᕐᕕᐅᓂᐊᖅᑐᑉ. ᑭᒃᑯᓕᒫᑦ ᐱᔭᕇᓚᐅᖅᑎᓪᓗᒋᑦ ᐊᕙᑎᒃᓴᖓᓂᒃ ᐃᓂᒃᓴᕆᔭᐅᒐᔭᖅᑐᒥᒃ 
ᐆᒪᔪᙳᐊᕐᓄᑦ ᐱᙳᐊᒐᕐᒥ ᓱᓇᒃᑯᑖᒃᓴᖏᖕᓂᒃ, ᑲᑐᔾᔨᔭᕆᐊᓖᑦ ᑕᑯᒃᓴᐅᑎᑕᐅᓗᑎᓪᓗ ᖃᐅᔨᓂᐊᕐᒪᑕ 
ᓱᖏᐅᑎᑎᑕᐅᔪᓐᓇᕐᓂᖏᖕᓂᒃ ᐊᒥᓱᒡᒍᑏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᓂᒃᓴᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᑦ. 
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ᐅᕝᕙ ᐅᑯᐊ ᐃᓂᒃᓴᙳᐊᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐅᙱᒥ: 

 

ᐅᕝᕙ ᐆᑦᑑᑎᐅᔪᖅ ᖃᓄᖅ ᓴᓇᒍᓐᓇᕐᒪᖔᖅᐱᐅᒃ ᐊᑐᕐᓗᑎᑦ ᐋᖅᑭᒃᓱᐃᒍᑎᒃᓴᖏᖕᓂᒃ ᐊᕙᑎᒃᓴᖓᓂᒃ ᐱᙳᐊᕈᑎᑉ: 

 

  

ᖃᕋᓴᐅᔭᒃᑯᑦ ᖃᓄᐃᓕᐅᕈᑎᒋᔭᐅᔪᓐᓇᖅᑐᑦ 

ᐋᖅᑭᒃᓱᐃᓗᓂ ᐃᓂᒃᓴᖏᖕᓂᒃ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ 
ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᖕᓂᒃ 
ᐊᑐᕐᓗᑎᑦ ᐃᓂᒃᓴᖏᖕᓂᒃ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖏᖕᓂᒃ ᐊᑐᖅᑕᐅᓗᐊᓲᖑᕗᖅ 
ᓴᓇᓗᓂ ᐊᕙᑎᒃᓴᖏᖕᓂᒃ ᒪᕐᕈᐃᓕᖅᑲᖓᙳᐊᖅᑑᔮᖅᑐᑦ ᑕᑯᓪᓗᒋᑦ 2D ᐱᙳᐊᕈᑎᒥ. ᐱᓕᕆᐊᖃᕐᓗᓂ 
ᖃᓄᐃᑦᑐᙳᐊᖑᒐᔭᖅᑐᑦ ᐆᒪᔪᙳᐊᑦ ᖃᕋᓴᐅᔭᒃᑯᑦ ᑎᑎᖅᑐᒐᐅᔭᕈᑎᒥ ᐊᑐᕐᓗᓂ ᑕᐃᑲᙵᑦ 
ᐃᓕᓐᓂᐊᕈᑎᒃᓴᐅᓚᐅᖅᑐᒥᒃ, ᐋᖅᑭᒃᓱᐃᓂᐊᖅᐳᒍᑦ ᐊᒥᓱᓂᑦ ᐃᓂᒃᓴᖏᖕᓂᒃ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ 
ᐊᕙᑎᖃᕐᓂᐊᕐᒪᑕ ᓴᓇᓗᒋᑦ ᐆᒪᔪᙳᐊᑦ ᖃᕋᓴᐅᔭᒃᑯᑦ ᑎᑎᖅᑐᒐᐅᔭᕈᑎᒧᑦ ᓴᓇᕙᐅᓯᒪᔪᓂᑦ ᓇᔪᒐᕆᒐᔭᖅᑕᖏᓐᓂᑦ. 
ᐱᒋᐊᕐᓂᐊᖅᐳᒍ ᓴᓇᓗᑕ ᐃᓛᒃᑰᖓᐅᖅᑐᓂᒃ ᐃᓂᒃᓴᙳᐊᕆᒐᔭᖅᑕᖏᖕᓂᒃ ᐆᒪᔪᙳᐊᑦ ᐱᙳᐊᕈᑎᑎᒍᑦ 
ᐊᑐᖅᑕᐅᒐᔭᖅᑐᓂᒃ. 

ᐋᖅᑭᒃᓱᐃᓂᖅ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᒃᓴᖏᖕᓂᒃ 
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ᒪᑐᐃᖅᓯᓗᑎᑦ ᒍᕌᐱᒃᔅᒐᐃᔪᓪᒥᒃ GraphicsGale ᐊᒻᒪᓗ ᐋᖅᑭᒃᓱᐃᓗᑎᑦ ᓄᑖᕐᒥᒃ ᐸᐃᑉᐹᒃᑯᕕᒃᓴᖓᓂᒃ 
(CTRL+N) ᐊᑐᕐᓗᑎᑦ 16x16 ᐊᖏᓂᓕᒃ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒃᓴᒥᒃ. ᐋᖅᑭᓪᓗᒍ ᐊᒥᐊᖏᑦ ᐃᒪᓐᓇ 
“8bit(256colours)”.  

 

ᓇᕿᓪᓗᒍ ᐊᖏᔪᖅ ᑭᑉᐹᕆᑦᑐᖅ ᖁᓛᓂ ᑕᓕᖅᐱᐊᑕ ᓄᑖᑉ ᑎᑎᕋᕐᕕᒃᓴᑉ ᐊᖏᓪᓕᒋᐊᕐᓂᐊᕐᒪᑦ ᐊᒻᒪᓗ ᐊᑐᕐᓗᑎᑦ 
ᐊᖏᓪᓕᑎᒋᐊᕈᑎ ᓇᕿᒐᒃᓴᖅ ᐊᖏᓪᓕᒋᐊᕈᑎᖓ ᑕᑯᒃᓴᐅᑎᑦᑎᓂᐊᕐᒪᑦ ᐊᒥᐊᕐᕕᖓᓂᒃ ᐅᕗᖓ 2000%. 
ᓇᕿᓪᓗᒍ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᓄᑦ ᐊᑐᕋᒃᓴᖅ ᓇᓗᓇᐃᒃᑯᑕᖓ ᑕᐃᑲᓂ ᐊᑐᕋᒃᓴᑦ ᓇᓗᓇᐃᒃᑯᑕᓖᑦ ᐃᓂᖃᕐᕕᖓᓂ 
ᐊᓯᔾᔨᖅᑕᖁᓪᓗᒋᑦ ᐊᔾᔨᒌᙱᑦᑐᑦ ᐊᑐᕋᒃᓴᐅᔪᑦ ᑭᑉᐹᕆᑦᑐᒡᒍᑎᓖᑦ ᓴᖅᑭᖅᑎᖁᓪᓗᒋᑦ ᖃᒥᖁᓪᓗᒋᓪᓗ. 
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ᐅᓪᓗᒥᐅᔪᖅ, ᖃᑦᑏᓐᓇᐅᓗᐊᕐᒪᑕ ᐊᒥᐊᕈᑎᒃᑯᕖᑦ ᐊᒥᐊᖏᑦ ᑕᓕᖅᐱᐊᓃᑦᑐᑦ. ᕿᕐᓂᖅᑕᑦ ᑭᑉᐹᕆᑦᑐᑦ ᐅᓪᓗᒥᐅᔪᖅ 
ᓱᑯᑦᑎᐊᓃᑎᑕᐅᓂᐊᕐᓂᖏᑦ ᐃᓕᔭᐅᓯᒪᙱᑲᓚᐅᕐᒪᑕ ᐃᓚᓯᒍᓐᓇᕐᓗᑕ ᐊᒥᐊᑦᑎᓐᓂᒃ. ᓇᕿᓪᓗᒋᑦ ᐊᒥᐊᖏᑦ 
ᐊᒻᒪᓗ ᐊᑐᕐᓗᒍ RGB/HSL/HSV ᐊᓪᓕᕐᒥ ᐊᑐᕋᒃᓴᐅᔪᑦ ᐊᒥᐊᕆᕕᒃᓴᑦ ᐊᓪᓕᕐᒥ ᐋᖅᑭᖁᓪᓗᒍ ᐊᒥᐊᕆᓂᐊᖅᑕᖓ 
ᐃᓂᒃᓴᓕᐅᕈᑎᒋᓂᐊᖅᑕᕕᑦ ᐊᕙᑎᖓᑕ ᐱᙳᐊᕈᑎᒥ. ᐃᓱᒪᓗᑎᑦ ᐊᒥᐊᑉ ᑕᑯᒃᓴᐅᓛᖑᒐᔭᕐᓂᖓ 
ᐃᓂᒃᓴᖃᕐᕕᙳᐊᖓ ᐊᑐᕈᒪᒐᔭᖅᑕᐃᑦ ᓴᓇᓗᒍ ᐊᒻᒪᓗ ᐆᑦᑐᕋᕐᓗᒋᑦ ᖃᓄᐃᑦᑑᓂᐊᓕᕐᓂᖏᑕ ᐊᕙᑎᖏᑦ ᐊᒥᐊᑉ 
ᓈᒻᒪᒋᓕᕐᓗᒍ. ᐊᒥᐊᑦ ᓂᕈᐊᓚᐅᖅᑎᓪᓗᒍ, ᓂᕈᐊᕐᓗᒍᓗ ᐃᓗᓪᓕᕆᐊᓕᒻᒥᒃ ᓇᓗᓇᐃᒃᑯᑕᖅ ᑕᐃᑲᙵᑦ 
ᓂᕈᐊᒐᒃᓴᐅᔪᓂᒃ ᐊᒻᒪᓗ ᓇᕿᓪᓗᒍ ᓱᑯᑦᑎᐊᓅᕈᒪᒻᒪᖔᖅᐱᐅᒃ ᐊᒥᐊᕆᓂᐊᖅᑕᖕᓄᑦ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒋᓗᒍ. 
ᑕᒪᓐᓇ ᐃᒪᐃᒐᔭᖅᑐᖅ ᐊᒥᐊᕆᕕᒻᒧᑦ ᓄᑖᕐᒥᒃ ᐊᒥᐊᕐᒥᒃ ᐊᑐᕐᓗᓂ. 
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ᐊᑐᕐᓂᐊᓕᕐᒥᔪᒍᑦ ᐊᒥᐊᕐᒥᒃ ᓂᕈᐊᕋᑖᖅᑕᖕᓂᑦ ᑐᙵᕕᒋᓗᒍ ᐱᐅᔫᓂᖓ ᐊᒥᐊᑦᑎᐊᕈᑏᑦ ᐊᔾᔨᒌᙱᑦᑐᓂᒃ 
ᐊᒥᐊᕐᓂᒃ ᓴᖅᑭᑦᑐᖃᓕᖁᓪᓗᒍ. ᓇᕿᓪᓗᒍ CTRL+left-click ᐊᒥᐊᕈᑎᑉ ᑭᑉᐹᕆᑦᑐᖏᖕᓂᒃ ᐊᒻᒪᓗ ᓅᓪᓗᒍ 
ᓄᑖᕐᒧᑦ ᐃᓗᓕᖃᙱᑦᑐᒧᑦ. ᐊᒥᓱᓕᐅᕐᓗᒍ ᑕᒪᓐᓇ ᑕᐃᒪᓐᓇᐃᓕᐅᖅᑎᓪᓗᑎᑦ ᓱᑲᓐᓂᖅᓴᐅᕗᖅ 
ᐃᖅᑲᐅᒪᒐᓱᐊᕐᓗᑎᑦ ᖃᓄᑦᑐᒥᒃ ᐊᒥᐊᕐᒥᒃ ᓂᕈᐊᖅᑲᐅᒻᒪᖔᖅᐱᑦ ᐊᒻᓗ ᓇᕿᒃᑲᓐᓂᕐᓗᒋᑦ RGB ᐱᐅᔫᓂᖓᓂᒃ. 
ᓇᕿᓪᓗᒍ ᐊᒥᓱᓕᐅᕈᓐᓇᐅᑎ ᐊᒻᒪᓗ ᐋᖅᑭᒋᐊᕐᓗᒍ. ᐊᑐᕐᓗᑎᑦ HSL ᓇᕿᑎᒐᖓ ᐋᖅᑭᒋᐊᖁᓪᓗᒍ ᖃᐅᒪᔨᓂᖓ 
ᓂᕈᐊᒐᒃᓴᖅ ᖃᐅᒻᒪᑎᕐᔫᒥᓗᒍ ᒪᓕᓪᓗᒍ ᐊᒥᐊᑦ ᐊᑐᕐᓂᐊᖅᑕᐃ.ᑦ ᐊᑐᕐᓗᑎᑦ ᑎᑎᕋᐅᑎᒥᒃ, ᐊᒻᒪᓗ ᐊᑐᓕᕐᓗᒍ ᑖᓐᓇ 
ᖃᐅᒪᓂᖅᓴᖅ ᐊᒥᐊᑉ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ. 
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ᐃᓚᓯᖃᑦᑕᑐᐃᓐᓇᕐᓗᑎᑦ ᐊᒥᐊᕐᓂᒃ, ᖃᐅᒪᓂᖅᓴᐃᓗᑎᑦ ᐊᒻᒪᓗ ᑖᓂᑭᑦᑑᓂᖅᓴᐅᓗᑎᑦ, ᓈᒻᒪᒋᓕᕋᓱᐊᕐᓂᕐᓂ.  
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ᑐᖅᑯᕐᓗᒋᑦ ᐱᔭᕇᖅᓯᒪᔭᑎᑦ ᐸᐃᑉᐹᒃᑯᕕᒻᒧᑦ ᐅᕗᙵᕐᓗᑎᑦ ᐸᐃᑉᐹᒃᑯᕕᒃ/ᑐᖅᑯᕐᓗᒍ File/Save As. ᓂᕈᐊᕋᒃᓴᑦ 
ᑭᑉᐹᕆᑦᑐᓃᑦᑐᑦ ᒪᑐᐃᖅᑎᓪᓗᒍ, ᐋᖅᑭᓪᓗᒍ ᓱᑯᑦᑎᐊᓅᕈᒪᒻᒪᖔᖅᐱᐅᒃ ᐸᐃᑉᐹᓕᐊᕆᓯᒪᔭᐃᑦ, ᓇᕿᓪᓗᒍ ᐊᑎᖓ, 
ᐊᒻᒪᓗ ᓂᕈᐊᕐᓗᒍ PNG ᑕᐃᑲᓂ “ᑐᖅᑯᕐᓗᒍ ᖃᓄᐃᑦᑑᓂᖓ:” “Save as type:” ᓂᕈᐊᕋᒃᓴᐅᔪᓂᒃ 
ᖃᓄᐃᓕᐅᕈᑎᖃᕐᓗᓂ ᖃᕋᓴᐅᔭᒃᑯᑦ ᐊᒻᒧᐊᑦᑎᓪᓗᒍ ᓴᖅᑭᑲᓐᓂᓲᑦ. ᓇᕿᓕᕐᒥᓗᒍ ᑐᖅᑯᕐᓗᒍ Save. 

ᑕᐃᒪᓐᓇᐃᓕᐅᒃᑲᓐᓂᕐᓗᑎᑦ, ᐊᒥᓱᓂᑦ ᐃᓂᒃᓴᖏᖕᓂᒃ ᐱᙳᐊᕈᑕᐅᓂᐊᖅᑑᑉ ᓴᓇᒌᕋᓱᐊᕐᓂᕐᓂ ᐊᑐᕈᓐᓇᑕᕐᓂᒃ 
ᐱᐅᔪᒥᒃ ᐊᑦᑎᓂᖅᓴᒥᒃ ᖁᑦᑎᓐᓂᖃᕐᓗᓂ ᐆᒪᔪᙳᐊᕆᓂᐊᖅᑕᐃᑦ. ᐃᖅᑲᓇᐃᔮᖃᓕᕐᓂᐊᓕᕐᒥᔪᒍᑦ ᓄᑖᕐᒥᒃ 
ᐸᐃᑉᐹᒃᑯᕕᒻᒥᒃ, ᐊᒻᒪᓗ ᑕᐃᑯᙶᖅᑲᕐᓗᒋᑦ ᐃᓂᒃᓴᖏᑦ ᐱᙳᐊᕐᕕᐅᓂᐊᖅᑑᑉ ᓴᓇᓂᐊᕋᕕᑦ ᖃᓄᐃᑦᑐᒥᒃ 
ᐊᑐᕋᔭᕐᒪᖔᕐᒥᒃ ᐱᙳᐊᕈᑎᒋᔭᐅᓂᐊᖅᑐᖅ. 

ᓴᓇᓗᑎᑦ ᓄᑖᕐᒥᒃ ᐸᐃᑉᐹᒃᑯᕕᒻᒥᒃ (CTRL+N), ᐋᖅᑭᓪᓗᒍ ᐊᖏᓂᖓ ᐅᕗᖓ 80x80px, ᐊᒻᒪᓗ ᐊᒥᐊᖓ 
ᐃᒪᓐᓇᐃᑦᑐᕈᖅᑎᓪᓗᒍ “16bit(64000colors)”. ᐊᑐᕐᓗᑎᑦ 8−ᖑᔪᓂᒃ ᐊᒥᐊᓕᖕᓂᒃ ᐊᑐᖅᑕᐅᔭᕗᑦ 
ᒥᑭᓂᖅᓴᐅᒻᒪᑕ ᐊᒻᒪᓗ ᐱᔭᕆᐊᑭᓐᓂᖅᓴᐅᓪᓗᑎᑦ ᐊᑐᕐᓗᒋᑦ, ᑭᓯᐊᓂᓕ ᑕᐃᒃᑯᐊ ᐊᒥᐊᑦ ᐊᑐᖅᑕᒥᓂᖅᑎᑦ 
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ᓇᓗᓇᐃᒃᑯᓯᖅᑕᐅᓂᐊᖅᑐᑦ, ᐊᒻᒪᓗ ᐊᒥᐊᖏᑕ ᑐᑭᓯᒋᐊᕈᑎᖏᑦ ᓱᑯᑦᑎᐊᓃᓐᓂᖏᓪᓗ ᐊᒥᐊᕈᑎᖃᕐᕕᒻᒥ 
ᐃᓚᒋᔭᐅᓕᕐᓂᐊᖅᑐᑦ ᐸᐃᑉᐹᒃᑯᕕᒻᒧᑦ. ᐊᓯᐊᓅᒃᑲᓐᓂᕐᓂᕈᑦᑎᒍᑦ 9−ᖑᔪᓂᑦ ᐊᒥᐊᕈᑎᖃᕐᕕᒻᒥ, ᐊᒥᐊᖏᑦ 
ᓂᕈᐊᖅᑕᕗᑦ ᐊᓯᔾᔨᕐᓂᐊᖅᑐᑦ ᐃᓚᔭᐅᓂᐊᕐᒪᑕ ᐅᓪᓗᒥᐅᔪᖅ ᐊᒥᐊᕈᑎᑦᑎᓐᓄᑦ, ᐊᒻᒪᓗ ᓴᖅᑭᕋᔭᙱᑦᑐᑎᑦ 
ᐊᑑᑎᒋᓇᓱᐊᖅᑕᑎᓐᓂᒃ. 

 

ᒥᑭᓪᓕᑎᒋᐊᕐᓗᒍ ᑕᑯᒃᓴᐅᔾᔪᑎᖓ ᐊᒻᒪᓗ ᐋᖅᑭᓪᓗᒍ ᐊᖏᓪᓕᒋᐊᕈᑎᖓ ᑕᑯᒃᓴᐅᓂᐊᖅᑐᖅ ᐊᒥᐊᕆᓂᐊᖅᑕᐃᑦ 

ᐃᒪᓐᓇᒧᑦ 400%. ᒫᓐᓇᓕ ᑕᐃᒪ ᐊᑐᕐᓂᐊᓕᕐᒥᔪᒍᑦ ᓄᑖᕐᒥᒃ ᑭᑉᐹᕆᑦᑐᕋᓛᓕᓐᓂᒃ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒃᓴᒥᒃ.  
ᓇᓗᓇᐃᒃᑯᑕᖓ ᓴᓂᐊᓃᑦᑐᖅ ᑭᑉᐹᕆᑦᑐᕋᓛᓖᑦ ᐊᑐᕋᒃᓴᒥ ᑕᐃᑲᓂ ᓂᕈᐊᕋᒃᓴᖃᕐᕕᐅᔪᓂᒃ ᐊᑐᖅᑕᐅᓂᐊᖅᑐᓂᑦ. 
ᓇᕿᓪᓗᒍ ᐊᒻᒪᓗ ᓂᕈᐊᕐᓗᒍ ᐅᓇ ᐊᖏᓂᖓ 16x16 ᑕᐃᑲᓂ ᑭᑉᐹᕆᑦᑐᑉ ᐃᓗᐊᓂ ᓂᕈᐊᕋᒃᓴᐅᔪᑦ ᓴᖅᑭᓲᓂ. 
ᑕᒪᓐᓇ ᐋᖅᑮᓂᐊᖅᑐᑦ ᓇᓕᐊᓐᓃᓕᕐᓂᖏᖕᓂᒃ ᑭᑉᐹᕆᑦᑐᕋᓛᑦ ᓇᓕᒧᒌᓕᖅᑎᒐᒃᓴᐅᑦᑎᐊᕐᓂᐊᕐᒪᑕ ᐊᖏᓂᖓᓄᑦ 
ᐊᑐᖅᑕᑎᓐᓄᑦ 16x16px ᐃᓂᒃᓴᕆᔭᐅᓂᐊᖅᑐᑦ ᐱᙳᐊᕈᑎᓕᐊᕐᒥ. ᓅᓪᓗᒋᑦ ᐃᓂᒃᓴᓕᐊᕆᓯᒪᔭᑎᑦ ᐅᕗᙵᕐᓗᑎᑦ 
Edit>Import. ᓂᕈᐊᕐᓗᒍ ᐊᑕᐅᓯᖅ ᐃᓂᒃᓴᕆᔭᐅᙳᐊᕐᓂᐊᖅᑐᑦ ᖃᓄᐃᑦᑑᓂᒃᓴᖓ ᐱᙳᐊᕈᑎᒥ ᐊᒻᒪᓗ 
ᓇᕿᒻᒥᓗᒍ “ᒪᑐᐃᕐᓗᒍ” “Open”. 
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ᓅᓪᓗᒍ ᖃᕋᓴᐅᔭᒃᑯᑦ ᑎᒃᑯᐊᖅᑕᕈᑎᖓ ᑕᐃᑲᓄ ᓱᓇᒃᑯᑖᙳᐊᕐᒧᑦ ᐃᓂᖃᕐᓂᐊᖅᑐᒧᑦ ᐱᙳᐊᕈᑎᒥ 
ᐊᓯᔾᔨᕋᓱᐊᕐᓂᖓᓂ ᑎᓴᒪᐃᓕᖅᑲᖓᔪᖅ ᑎᒃᑯᐊᖅᑕᕈᑎᖓ. ᑖᓐᓇ ᓅᑦᑎᑦᑎᒍᑎᐅᕗᖅ ᓇᓗᓇᐃᒃᑯᑕᓕᒃ. 
ᓴᐅᒥᐊᓃᑦᑐᖅ ᓇᕿᓪᓗᒍ Left-click ᐊᒻᒪᓗ ᓅᓪᓗᒍ ᓱᓇᒃᑯᑖᙳᐊᒃᓴᖅ ᐃᓚᖓᓄᑦ ᑭᑉᐹᕆᑦᑐᓄᑦ. ᑕᓕᖅᐱᐊ 
ᓇᕿᓪᓗᒍ ᓇᒧᑐᐃᓐᓇᖅ ᑕᐃᕙᙶᕐᓗᓂ ᓱᓇᒃᑯᑖᙳᐊᕐᓂᒃ ᐋᖅᑭᑦᑕᐅᓂᐊᕐᒪᑦ ᐊᒻᒪᓗ 
ᓂᕈᐊᖅᑕᐅᓯᒪᒍᓐᓃᕐᓂᐊᕐᒪᑦ. ᓅᒋᐊᕈᑎᖓ ᖃᕋᐅᓴᔭᒃᑯᑦ ᑎᒃᑯᐊᖅᑕᕈᑎ ᐊᓯᔾᔨᓕᕋᔭᖅᑐᖅ ᓅᒐᒃᓴᐅᓕᕐᓗᓂ. 
ᓂᕈᐊᒃᑲᓐᓂᖁᓪᓗᒍ ᐃᓂᒃᓴᖓ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ, ᓅᓪᓗᒍ ᓇᕿᑎᔾᔪᑎ ᑕᑯᒃᓴᐅᔪᖅ 
ᓱᑯᑦᑎᐊᓅᕋᒃᓴᕈᑎᖏᑦ ᑎᕆᖅᑯᐊᓄᑦ, ᓴᐅᒥᐊ−ᓇᕿᓪᓗᒍ Left-click, ᐊᒻᒪᓗ ᑭᑉᐹᕆᑦᑐᑦ ᓂᕈᐊᖅᓯᒪᔭᑎᑦ ᓅᓪᓗᒋᑦ. 
ᓅᒃᑲᓐᓂᓕᕐᒥᓗᒍ ᐃᓂᒃᓴᖓ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᖏᑦ ᓂᕈᐊᖅᑕᐅᓯᒪᒍᓂ, ᐅᕝᕙᓘᓐᓃᑦ 
ᓇᕿᓪᓗᒍ CTRL+C ᐊᒥᓱᓕᐅᕐᓗᒍ. CTRL+V ᐃᓕᓯᓂᐊᖅᑐᖅ ᐊᔪᕆᖅᑲᐅᔭᕐᓂᒃ ᖁᓈᓄᑦ ᓱᓇᒃᑯᑖᖑᔪᒧᑦ. 
ᓴᐅᒥᐊ−ᓇᕿᓪᓗᒍ Left-click ᐊᒻᒪᓗ ᓅᓪᓗᒍ ᓄᑖᕐᒧᑦ ᐊᓯᐊᓄᑦ ᐃᓂᒃᓴᖓᓄᑦ, ᐊᒻᒪᓗ ᑕᓕᖅᐱᐊ−ᓇᕿᓪᓗᒍ 
right-click ᓇᕿᓕᕐᒥᓗᒍ ᓂᕈᐊᖅᓯᒪᓂᖏᑦ ᐲᕐᓂᐊᕐᒪᑕ ᐊᒻᒪᓗ ᐃᓕᔭᐅᓗᓂ. ᐊᒥᓱᐊᖅᑎᖅ 
ᑕᐃᒪᐃᓕᐅᕆᐊᖃᕈᕕᑦ ᑕᐃᒪᓐᓇᐃᓕᐅᖃᑦᑕᕐᓗᑎᑦ. 
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ᐊᑐᕐᓗᒍ ᐋᖅᑭᒋᐊᕈᑎᖓ>ᐊᓯᐊᓄᐊᖅᑕᐅᔾᔪᑎ Edit>Import ᐊᓯᖏᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑦ 
ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᖏᑦ ᓴᖅᑭᓂᐊᕐᒪᑕ. ᐃᓚᔭᐅᓕᕋᔭᖅᑐᑦ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒃᓴᒧᑦ ᑕᐃᒫᒃᓴᐃᓐᓇᖅ ᖁᓛᓂ 
ᑕᐃᒪᐃᓕᐅᖅᑲᐅᒐᕕᑦ, ᐊᒻᒪᓗ ᓂᕈᐊᕈᓐᓇᖅᑕᑎᑦ, ᐊᒥᓱᓕᐅᕐᓗᒋᑦ ᐊᒻᒪᓗ ᐃᓕᓗᒋᑦ ᑕᐃᒪᐃᒋᐊᖃᕈᕕᑦ. 
ᐱᙳᐊᕈᑎᑉ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᓱᓇᒃᑯᑖᖏᑦ ᐋᖅᑭᒃᓱᑐᐃᓐᓇᕐᓗᒋᑦ ᐱᔭᕇᕋᓱᐊᕐᓂᕐᓂ. 
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ᒫᓐᓇᓕ ᑕᐃᒪ ᓴᖅᑭᑎᓐᓂᐊᓕᕐᒥᔭᐃᑦ ᐆᒪᔪᙳᐊᑦ. ᓅᑲᓪᓚᒍᒪᙱᓐᓇᑦᑎᒍᑦ ᓱᓇᒃᑯᑖᑦ ᐋᖅᑭᓱᖅᑕᐅᔭᕗᑦ, 
ᑕᐃᒪᐃᒻᒪᑦ ᐊᑐᕐᓂᐊᖅᑐᒍᑦ ᓄᑖᕐᒥᒃ ᖃᓕᕇᒍᑎᒥᒃ Layer. ᖃᓕᒌᒍᑎ ᓄᑖᖑᕗᖅ ᑎᑎᖅᑐᒐᐅᔭᕐᕕᒃᓴᖅ ᐊᔾᔨᖓᓂᒃ 
ᑎᑎᖅᑐᒐᐅᔭᖅᑲᐅᔭᕐᓂᒃ ᐱᑕᖃᖅᑐᓂ, ᖁᓛᓃᒍᓐᓇᖅᑐᖅ ᐊᓪᓕᕐᒥᓪᓘᓐᓃᑦ ᓱᓇᒃᑯᑖᓕᐊᕆᓯᒪᔭᕐᓂᒃ ᐊᔾᔨᙳᐊᓂᒃ. 
ᓇᕿᓪᓗᒍ ᖃᓕᕇᒍᑎᒃᑲᓐᓂᕐᒥᒃ ᐃᓚᓯᑎᑦᑎᒋᐊᕈᑎ ᖃᓕᕇᑦᑐᒥᒃ Add Layer ᓇᕿᑎᒐᖅ ᑕᐃᑲᓂ ᓂᕈᐊᕋᒃᓴᓂᒃ 

ᐊᑐᕈᓐᓇᑕᕐᓂᒃ ᖃᕋᓴᐅᔭᒃᑯᑦ.  ᑖᓐᓇ ᐃᓚᓯᓂᐊᖅᑐᖅ ᓄᑖᕐᒥᒃ ᖃᓕᕇᑦᑐᒥᒃ ᐊᔾᔨᙳᐊᕐᒧᑦ ᐊᒻᒪᓗ 
“ᖃᓕᕇᓐᓂᖓ 2” ᓴᖅᑭᓕᕋᔭᖅᑐᖅ ᑕᐃᑲᓂ ᐊᒥᐊᕐᕕᒋᖅᑲᐅᔭᕐᓂᒃ ᓴᐅᒥᐊᓃᑦᑐᓂᑦ. 
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ᐊᒥᐊᕐᕕᒋᔭᐃᑦ ᖃᓕᕇᑦᑐᖅ ᐊᒥᐊᕐᕕᒃ ᕿᕐᓂᓂᖅᓴᒥᒃ ᑐᖑᔪᖅᑑᒦᑉᐳᖅ ᖃᐅᔨᒃᑲᐃᒍᑎᖃᖅᑐᓂ ᐊᒥᐊᕐᒥᒃ, ᑕᐃᒃᑯᐊ 
ᐊᒥᐊᕐᕕᒋᙱᑕᑎᑦ ᖃᓕᕇᑦᑐᑦ ᓯᐊᕐᓇᐅᓪᓗᑎᑦ ᐊᒥᐊᖏᑦ. ᐊᑐᕐᓗᒋᑦ ᓇᕿᑎᒐᑦ ᓱᑯᑦᑎᐊᓅᖓᙳᐊᖅᑐᑦ 
ᖃᓕᕇᑦᑐᒥᒃ ᓅᖁᓪᓗᒍ ᐊᒥᐊᕆᕕᒃᑲᓐᓂᖅ ᖃᓕᕇᓐᓂᖓ ᖁᓛᓄᑦ ᐊᒻᒪᓗ ᐊᒻᒧᑦ, ᑭᓯᐊᓂᓕ ᒫᓐᓇ ᑖᓐᓇ 
ᖃᓕᕇᓐᓂᖓ ᓂᕈᐊᕋᑖᖅᑕᐃᑦ 2 ᖁᓛᓃᖁᕙᕗᑦ. ᑕᐃᑯᙵᕐᓗᑎᑦ ᐋᖅᑭᒋᐊᕈᑎᖓ>ᐊᓯᐊᓄᐊᖅᑕᐅᔾᔪᑎ 
Edit>Import ᐊᒻᒪᓗ ᓇᓂᓗᒍ ᒪᑐᐃᕐᓗᒍᓗ ᐆᒪᔪᙳᐊᓕᐊᕆᖅᑲᐅᔭᐃᑦ ᐋᖅᑭᓱᖅᑐᒍ ᓯᕗᓂᐊᓂ ᐃᓕᓐᓂᐊᕈᑎᒥ 
(ᐃᓕᓐᓂᐊᕐᓂᙱᒃᑯᕕᐅᒃ ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᖅ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ 2 ᐃᓕᓐᓂᐊᕋᒃᓴᖅ, ᐋᖅᑮᒍᓐᓇᖅᑐᑎᑦ 
ᐊᒻᒪᓗ ᑐᖅᑯᕐᓗᒍ ᐆᒪᔪᙳᐊᖑᓂᐊᖅᑐᖅ, ᐅᕝᕙᓘᓐᓃᑦ ᑎᑎᖅᑐᒐᐅᔭᑦᑎᐊᒻᒪᕆᓪᓗᒍ ᑕᕝᕙᓂ ᖃᓕᕇᑦᑐᒥ 
ᐊᒥᐊᕐᕕᒃᓴᒥ).  
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ᐃᓕᓗᒍ ᐆᒪᔪᙳᐊᑦ ᓱᑯᑦᑎᐊᓃᖁᒻᒪᖔᖅᐱᐅᒃ ᐱᙳᐊᕈᑎᑉ ᐊᕙᑎᒋᓂᐊᖅᑕᖓᓂᒃ, ᐊᒻᒪᓗ ᐊᑐᓕᕐᒥᓗᒍ 
ᐸᐃᑉᐹᒃᑯᕕᒃ>ᑐᖅᑯᕐᓗᒍ ᐅᕗᖓ File>Save As ᑐᖅᑯᕐᓂᐊᕋᕕᐅᒃ ᑕᒪᐃᓐᓂ ᐊᔾᔨᙳᐊᖅ ᐊᔾᔨᙳᐊᖑᒍᓐᓇᐅᑎᒥ 
ᐸᐃᑉᐹᒃᑯᕕᐅᔪᒧᑦ PNG ᐸᐃᑉᐹᒃᑯᕕᖓᑕ ᑐᖅᑯᐃᕕᖓᓄᑦ. ᐊᔾᔨᙳᐊᑦ ᐊᖏᓪᓕᒋᐊᖁᒍᕕᐅᒃ ᑐᖅᑯᓚᐅᙱᓐᓂᕐᓂ, 
ᐅᕗᙵᕐᓗᑎᑦ ᑕᒪᐃᓐᓂ ᐊᔾᔨᙳᐊᑦ>ᐆᑦᑐᓕᖅᑭᑦᑖᓗᒍ All Frames>Resample, ᓇᕿᒍᓐᓃᖅᑎᓪᓗᒍ 
“ᐊᒥᐊᖃᑦᑎᐊᓕᕐᓗᓂ” “Smooth” (ᐱᐅᓛᖑᕗᑦ ᓇᕿᑎᓯᒪᒍᓐᓃᖅᑏᓐᓇᖃᑦᑕᕈᕕᐅᒃ, ᐋᖅᑭᓪᓗᒍᓗ 
ᑕᐅᑐᒐᒃᓴᐅᓂᖓᑕ ᐳᓴᓐᑎᖓ ᐅᕗᖓ 200%, ᐊᒻᒪᓗ ᓇᕿᓪᓗᒍ ᑕᐃᒪ OK. ᑐᖅᑯᕐᓗᒍ ᐃᒪᓐᓇ, Save As, 
ᐊᒻᒪᓗ ᖁᕕᐊᒋᒍᒃ ᒥᑭᔪᖅ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᖏᑦ ᐱᙳᐊᕐᕕᐅᓂᐊᖅᑐᑉ 
ᐊᕙᑎᖓ ᓴᓇᖅᑲᐅᔭᐃᑦ! 
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ᐃᓱᓕᓐᓂᖓ 
ᐃᓛᒃᑰᖓᔪᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ ᐱᐅᓪᓚᕆᑦᑐᑦ ᐃᓕᔭᐅᓗᑎᑦ ᐊᔾᔨᐅᙱᑦᑐᑦ 
ᐊᔾᔨᙳᐊᑦ ᑕᕝᕗᖓ ᐃᓂᒃᓴᖓᓄᑦ, ᓅᑕᐅᒍᓐᓇᖅᑐᓂᒃ ᓴᓇᓗᑎᑦ, ᓱᑯᑦᑎᐊᓃᓐᓂᕆᔭᖏᖕᓂᒃ, ᐊᒻᒪᓗ ᐊᓯᖏᖕᓂᒃ 
ᐊᒥᓱᑦ ᐱᙳᐊᖅᑕᐅᔪᑦ ᓱᓇᒃᑯᑖᕆᒐᔭᖅᑕᖏᓐᓂᑦ. ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ 
tilesets ᓄᐊᑕᐅᓕᓲᑦ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ ᐊᒥᓱᓄᑦ ᑐᖅᑯᖅᑕᐅᓕᓲᖑᓪᓗᑎᑦ 
100-ᖑᓗᐊᖅᑐᓂᒃ ᐊᑐᓂ ᐸᐃᑉᐹᒃᑯᕕᓐᓅᖓᓗᑎᑦ ᐊᒻᒪᓗ ᐱᖁᑎᓕᐊᕆᔭᐅᓯᒪᔪᑦ ᐸᐃᑉᐹᒃᑯᕖᑦ 
ᖃᑦᑏᓐᓇᐅᑎᑕᐅᓗᑎᑦ. ᐊᑐᕐᓗᓂ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᓂᒃ ᐊᒻᒪᓗ ᐊᑐᓂ 
ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑕᖑᔪᒥᒃ ᑕᒪᒃᑮᒃ ᐊᑐᕋᒃᓴᐅᕘᒃ ᑲᒪᒋᔭᐅᓂᐊᕐᒪᑕ ᐃᓂᒃᓴᖏᑦ 
ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ ᐱᙳᐊᕈᑎᒥ, ᐊᒻᒪᓗ ᑭᐅᓂᐊᒍᑦ ᑐᙵᕕᖃᖅᑐᑎᑦ ᖃᕋᓴᐅᔭᕐᒧᑦ 
ᖃᓄᐃᑦᑑᓂᖓ ᐊᑐᖅᑕᐅᓂᖓᓂᒃ ᐊᒻᒪᓗ ᐊᑐᖃᑦᑕᕈᒪᓲᖓ ᐱᙳᐊᕈᑎᓕᐅᖅᑎᐅᔫᑉ. 

 

ᐃᑲᔫᑎᒃᓴᑦ  

ᐃᑲᔫᑎᒃᓴᒃᑲᓐᓃᑦ 
● DYA ᐱᙳᐊᕈᑏᑦ – ᖃᓄᐃᑦᑑᓂᐊᕐᓂᖓ ᐊᕙᑎᖓᑕ ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ ᐱᙳᐊᕈᑎᒥ 

ᓱᓇᒃᑯᑖᑦ ᐊᒥᓱᑦ ᐊᓂᒍᖅᐸᓪᓕᐊᑎᓪᓗᒍ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 
https://www.youtube.com/watch?v=3kPpfLmelIs 

● ᒍᕌᐱᒃᔅᒐᐃᔪᓪ GraphicsGale ᐃᖅᑲᓇᐃᔮᕆᔭᐅᓂᖏᑕ ᐃᓕᓐᓂᐊᑎᑦᑎᒍᑎ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 
https://www.youtube.com/watch?v=RNCsmqIR_vY) 

● ᒪᑐᐃᖓᔪᑦᐱᙳᐊᕈᑎᓕᐅᕐᓗᓂᑎᑎᖅᑐᒐᐅᔭᖅᑕᐅᔪᓐᓇᖅᑐᑦ − ᐃᓂᒃᓴᖏᑦ ᖃᓄᐃᑦᑑᒐᔭᕐᓂᖏᑕ 
ᐱᙳᐊᕈᑎᒥ ᓱᓇᒃᑯᑖᑦ ᖃᓄᐃᑦᑐᕈᓘᔭᐅᓂᖏᑦ ( ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 
https://opengameart.org/content/chapter-8-a-world-of-tiles) 

ᖃᕋᓴᐅᔭᒃᑯᑦ ᐃᓅᖃᑎᒌᒍᓐᓇᐅᑏᑦ ᐃᑲᔫᑏᑦ 
● ᑭᑉᐹᕆᑦᑐᒡᒍᑎᕋᓛᑦᑲᑎᖅᓱᖅᑕᐅᓂᖏᑦ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: http://pixeljoint.com/) 
● ᑭᑉᐹᕆᑦᑐᒡᒍᑎᕋᓛᑦ ᓴᓇᔭᐅᓂᖏᑦ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: https://pixelation.org/) 
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Pinnguaq • ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᖅ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ 3A 

● ᕆᐊᑎᑦᒥ – /ᐊᔾᔨᙳᐊᓕᐅᕈᑎᕋᓛᑦ ᑭᑉᐹᕆᑦᑐᒡᒍᑕᐅᓪᓗᑎᑦ ᓴᓇᔭᐅᓂᖏᑦ (ᑕᑯᓂᐊᕐᕕᐅᑉ ᐊᖅᑯᑎᖓ: 
https://www.reddit.com/r/pixelart) 
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